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Preface

Welcome to Developing Applications with Oracle ADF Desktop Integration.

Audience

This document is intended for enterprise developers who develop desktop
applications to integrate with the Oracle Application Development Framework (Oracle

ADF). It also provides information for system administrators and end users who work
with these desktop applications.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle

Accessibility Program website at ht t p: / / www. or acl e. conl pl s/ t opi ¢/ | ookup?
ct x=accé& d=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visitht t p: / / ww. or acl e. coni pl s/t opi ¢/ | ookup?

ct x=acc& d=i nf o or visit ht t p: / / www. or acl e. cont pl s/t opi ¢/ | ookup?
ct x=acc& d=t r s if you are hearing impaired.

Related Documents
For more information, see the following:

* Developing Fusion Web Applications with Oracle Application Development Framework

e Developing Web User Interfaces with Oracle ADF Faces

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements (for example,
menus and menu items, buttons, tabs, dialog controls), including
options that you select.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.
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What's New in This Guide for 12c (12.2.1.1)

The following topics introduce the new and changed features of ADF Desktop
Integration and other significant changes that are described in this guide, and
provides pointers to additional information.

For changes made to Oracle JDeveloper and Oracle Application Development
Framework (Oracle ADF) for this release, see the What's New page on the Oracle
Technology Network at ht t p: / / www. or acl e. coni t echnet wor k/ devel oper -
t ool s/ j dev/ docunent ati on/i ndex. htm .

New and Changed Features for 12¢ (12.2.1.1)

Oracle ADF Desktop Integration 12¢ (12.2.1.1) includes the following new and
changed development features for this document.

This release deprecates the ADF Button component. You are encouraged, but not
required, to replace ADF Button components in your integrated Excel workbooks
with ribbon commands. For more information, see Configuring the Runtime
Ribbon Tab.

New property, Fai | ur eMessage, where you can specify a message to appear to
the end user if an action set fails. For more information, see How to Configure
Error Handling for an Action Set.

New property (Act i onOpt i ons. NonBl ocki ng) that, when set to Tr ue, enables
your users to use other Excel features while an action set executes. Set this property
to Tr ue on action sets that may take time to complete such as, for example, a

Tabl e. Downl oad action for 100,000 rows. For more information, see How to
Allow End Users to Continue Working in Excel While an ActionSet Executes.

ADF Desktop Integration now enables end users to save a connection report with
diagnostic information when connection failures occur or are canceled. For more
information, see Generating ADF Desktop Integration Diagnostic Reports and
Troubleshooting Connection Problems to Fusion Web Applications.

ADF Desktop Integration now enables client-side logging by default
(I nf or mat i on level). For more information, see About Client-Side Logging.

This release introduces new menu options to provide easier access to you and end
users when generating the diagnostic report and enabling verbose logging to an
XML file in a directory that you choose. For more information, see:

— How to Generate the ADF Desktop Integration Diagnostic Report

— About Client-Side Logging
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— Providing Diagnostic and Logging Information to Technical Support

End users can now choose a time period (next week, next month, and so on) to
determine when they next receive a prompt to upgrade their ADF Desktop
Integration client version to match the server version. For more information, see
How to Upgrade ADF Desktop Integration On a Local System and Verifying the
Client Version of ADF Desktop Integration.

The ADF Desktop Integration add-in can now be installed to the roaming
application data folder (¥appdat a% using the ADF Desktop Integration installer
from the command line. For more information, see How to Run ADF Desktop
Integration Installer from Command Line.

This release includes the Client Health Check tool that verifies an environment is
configured to use integrated Excel workbooks. For more information, see Running
the Client Health Check Tool.

Added section to describe how you can control the display of the system check that
appears when an end user attempts to download an integrated Excel workbook
from a Fusion web application. For more information, see How to Manage the
Display of the System Check to End Users.

ADF Desktop Integration rejects Excel cell error values that integrated Excel
workbooks send to the Fusion web application. As a result, these values are not
successfully uploaded. For more information, including how to configure this
behavior, see Providing Data Entry Validation for an Integrated Excel Workbook.

Other Significant Changes in this Document for 12¢ (12.2.1.1)

XViii

For 12c (12.2.1.1), this document has been updated in several ways, to include
corrections and clarifications. In addition, the following significant changes or
additions have occurred in these sections:

® This guide now includes the Administering ADF Desktop Integration chapter that

was previously published in Administering Oracle ADF Applications.
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Introduction to ADF Desktop Integration

This chapter introduces ADF Desktop Integration and provides an overview of the
framework. The chapter also describes the advantages of integrating Microsoft Excel
with a Fusion web application.

This chapter includes the following sections:
* About ADF Desktop Integration

¢ About ADF Desktop Integration with Microsoft Excel

For definitions of unfamiliar terms found in this and other books, see the Glossary.

1.1 About ADF Desktop Integration

Many end users of Fusion web applications use desktop applications, such as
Microsoft Excel, to manage information also used by their web application. ADF
Desktop Integration provides a framework for Oracle Application Development
Framework (Oracle ADF) developers to extend the functionality provided by a Fusion
web application to desktop applications. It allows end users to avail themselves of
Oracle ADF functionality when they are disconnected from their company network.
End users may also prefer ADF Desktop Integration because it provides Excel's
familiar user interface to undertake information management tasks, such as
performing complex calculations or uploading a large amount of data, easily and
seamlessly.

ADF Desktop Integration is a part of the Oracle ADF architecture. More information
about the Oracle ADF architecture can be found in the "Oracle ADF Architecture"
section of Developing Fusion Web Applications with Oracle Application Development
Framework.

Figure 1-1 illustrates the architecture of ADF Desktop Integration, which comprises of
the following components:

¢ ADF Desktop Integration
e ADF Desktop Integration remote servlet

¢ ADF Model layer
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Figure 1-1 ADF Desktop Integration Architecture
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For more information about ADF Desktop Integration, see the ADF Desktop
Integration page on Oracle Technology Network (OTN) at:

http://ww. oracl e. com t echnet wor k/ devel oper -t ool s/ adf / over vi ew
i ndex- 085534. ht m

1.2 About ADF Desktop Integration with Microsoft Excel

Currently, ADF Desktop Integration supports integration with Microsoft Excel.

Note:

This guide uses the term integrated Excel workbook to refer to Excel workbooks
that you integrate with a Fusion web application and to distinguish these
workbooks from workbooks that have not been integrated with a Fusion web
application or configured with Oracle ADF functionality.

1.2.1 Overview of Creating an Integrated Excel Workbook

Creating an integrated Excel workbook involves the steps described in Table 1-1.

Table 1-1 Steps to Create an Integrated Excel Workbook
- |

Use To

JDeveloper ¢ Create a Fusion web application.

For information about creating a Fusion web application, see the
Developing Fusion Web Applications with Oracle Application Development
Framework.

* Add data controls that expose the elements you require in Microsoft
Excel.

¢ Create page definition files that expose the Oracle ADF bindings to use
in Excel.
For more information, see Working with Page Definition Files for an
Integrated Excel Workbook.
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Table 1-1 (Cont.) Steps to Create an Integrated Excel Workbook
________________________________________________________________________________|

Use To

Excel ¢ Create the Excel workbooks that you intend to configure with Oracle
ADF functionality.
For more information, see Adding an Integrated Excel Workbook to a
Fusion Web Application.

¢ Configure the Excel workbook using the Oracle ADF bindings that you
exposed in the page definition files and the Oracle ADF components
that ADF Desktop Integration provides.

For more information, see the following sections and chapters:
- Getting Started with the Development Tools

This chapter provides an overview of the tools that ADF Desktop
Integration provides to configure an Excel workbook with Oracle
ADF functionality.

- Working with ADF Desktop Integration Form-Type Components
This chapter describes how to insert ADF Desktop Integration form-

type components into Excel worksheets and configure their
properties to determine behavior at runtime.

- Working with ADF Desktop Integration Table-Type Components
This chapter describes how to use the ADF Table and Read-only

Table components to provide end users with a means of displaying
and editing data hosted by a Fusion web application.

— Adding Validation to Your Integrated Excel Workbook
This chapter describes how to provide validation for your integrated
Excel workbook.
e Test your integrated Excel workbook.
For more information, see Testing Your Integrated Excel Workbook.
e After completing the integration of the Excel workbook with the Fusion
web application, you deploy it to make it available to the end users.

For information about this task, see Deploying Your Integrated Excel
Workbook .

1.2.2 Advantages of Integrating Excel with a Fusion Web Application

Advantages that accrue from integrating Microsoft Excel workbooks with your Fusion
web application include:

* Providing end users with access to data and functionality hosted by a Fusion web
application through a desktop interface (Microsoft Excel) that may be more familiar
to them.

¢ End users can access data hosted by a Fusion web application while not connected
to the application. They must log on to the Fusion web application to download
data. Once data is downloaded to an Excel workbook, they can modify it while
disconnected from the Fusion web application.

* Bulk entry and update of data may be easier to accomplish through a spreadsheet-
style interface.

¢ End users can use native Excel features such as formulas and filters.
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Introduction to the ADF Desktop Integration
Sample Application

This chapter provides an overview of the Summit sample application for ADF
Desktop Integration. The Summit sample application for ADF Desktop Integration
contains several Microsoft Excel workbooks that are integrated with the sample's
Fusion web application.

This chapter includes the following sections:
® About the Summit Sample Application for ADF Desktop Integration

* Setting Up and Running the Summit Sample Application for ADF Desktop
Integration

¢ Overview of the Fusion Web Application in the Summit Sample Application for
ADF Desktop Integration

* Overview of the Integrated Excel Workbooks in the Summit Sample Application
for ADF Desktop Integration

2.1 About the Summit Sample Application for ADF Desktop Integration

The Summit sample application for ADF Desktop Integration is a set of sample
demonstrations that illustrate the main capabilities from ADF Desktop Integration.
Each of the samples contain specific features that can also be identified on the
developer's guide. All of the samples use the same underlying database schema which
makes it very easy for accessing the source code, and also to experience the runtime
behavior in a standalone way.

2.2 Setting Up and Running the Summit Sample Application for ADF
Desktop Integration

Set up the development environment as described in Setting Up Your Development
Environment before you download and run the Summit sample application for ADF
Desktop Integration.

Running the Summit sample application for ADF Desktop Integration requires you to:

1. Download the application resources, as described in How to Download the
Application Resources.

2. Run the Summit sample application, as described in How to Run the Summit
Sample Application for ADF Desktop Integration.

2.2.1 How to Download the Application Resources

You download the application resources from Oracle Technology Network.
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To download the Summit sample application for ADF Desktop Integration:

1. Download and install Oracle JDeveloper. For more information, see Installing
Oracle JDeveloper.

2. Install ADF Desktop Integration. For more information, see Installing ADF
Desktop Integration.

Note:

If you have an old version of ADF Desktop Integration installed on your
system, upgrade ADF Desktop Integration as described in Upgrading ADF
Desktop Integration.

3. Download and install the Summit ADF schema. For more information, see the
"How to Install the Summit ADF Schema" section in Developing Fusion Web
Applications with Oracle Application Development Framework.

4. Download and install the Summit sample application for ADF Desktop
Integration ZIP file from Oracle Technology Network.

http://ww. oracl e. conf pl s/t opi ¢/l ookup?ct x=E26099_01&i d=j devcodesanpl es

For more information, see How to Run the Summit Sample Application for ADF
Desktop Integration.

2.2.2 How to Run the Summit Sample Application for ADF Desktop Integration

To run the Summit sample application, extract the contents of the zip file and open
the . JWE file in JDeveloper.

To run the Summit sample application for ADF Desktop Integration:
1. Extract the contents the zip file to a local directory.

2. Open the Sunmi t ADFdi . j ws file in JDeveloper.
This file is located in the Sunmi t _ADFDI directory.

3. In the Applications window, click and expand the Model project.
4. Open Model > Application Sources > oracle.summitdi.model > Model.jpx file.

5. Expand the Connection group of the General tab, and click the Add icon to create
a database connection.

6. In the Create Database Connection dialog, add the connection information shown
in Table 2-1 for your environment.

Table 2-1 Database Connection Properties for the Summit Sample Application
for ADF Desktop Integration

Property Description
Username c##summi t _adf
Password sunm t _adf
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Table 2-1 (Cont.) Database Connection Properties for the Summit Sample

Application for ADF Desktop Integration
_______________________________________________________________________|

Property Description

Host Name The host name for your database.
For example:
| ocal host

JDBC Port The port for your database.
For example:
1521

SID The SID of your database.
For example:
ORCL or XE

Click Test Connection to verify the connection, and then click OK to close the
dialog.

7. Save the Model . j px file.

8. Select the ViewController project and click the Run button in JDeveloper's main
menu.

2.3 Overview of the Fusion Web Application in the Summit Sample
Application for ADF Desktop Integration

The Fusion web application in the Summit sample application for ADF Desktop
Integration enables end users to download the integrated Excel workbooks.

2.3.1 About the Fusion Web Application in the Summit Sample Application for ADF
Desktop Integration

When the end user runs the Summit sample application for ADF Desktop Integration
in JDeveloper, the default browser opens the application home page. The end user can
download various integrated Excel workbooks from the home page.
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Figure 2-1 Home page of Summit Sample Application for ADF Desktop Integration
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This sample illustrates the most commonly used ADF Desktop Integration Table features. You can download, inser, update and
commit data. It also demonstrates multiple ways to choose avalue from a list of choices.

2.3.2 Downloading Integrated Excel Workbooks

The Summit sample application for ADF Desktop Integration provides various
integrated Excel workbooks to meet different requirements. End users can navigate
and download different workbooks from the Mai nPage. j sf of the application. When
an end user clicks a link to download a workbook, a Java applet verifies that the ADF
Desktop Integration add-in is present on the end user’s machine. If the add-in is
found, the workbook download begins automatically. Otherwise, ADF Desktop
Integration prompts the end user to install the add-in. If Java is not installed on the
end user’s machine or is disabled by the end user’s security settings, the Java applet is
unable to verify the presence of the ADF Desktop Integration add-in. ADF Desktop
Integration informs the end user that the installation of the add-in cannot be verified.
It presents the end user with the option to download the workbook and/or install the
add-in.

Table 2-2 lists the menu options and the downloaded integrated Excel workbooks.

Table 2-2 Integrated Excel Workbooks of Summit sample application for ADF

Desktop Integration
- __________________________________________________________|

Menu Option Description

Edit Customers Sample Downloads Edi t Cust orrer s. x| sx workbook.

Edit Warehouse Inventory =~ Downloads Edi t ar ehousel nvent ory. x| sx workbook.
Sample

Edit All Inventory Sample  Downloads Edi t Al | | nvent ory. x| sx workbook.

Search Customers Sample ~ Downloads Cust onmer Sear ch. x| sx workbook.

2-4 Developing Applications with Oracle ADF Desktop Integration



Overview of the Integrated Excel Workbooks in the Summit Sample Application for ADF Desktop Integration

2.4 Overview of the Integrated Excel Workbooks in the Summit Sample
Application for ADF Desktop Integration

The Summit sample application for ADF Desktop Integration provides the
Cust oner Sear ch. xl sx, EditAl Il nventory. xl sx, EditCustomers. x| sx,
and Edi t War ehousel nvent ory. x| sx integrated Excel workbooks.

The Cust orrer Sear ch. x| sx workbook demonstrates how a custom web page can be
used to perform a search prior to downloading data into an ADF Table component
configured to be read-only.

The Edi t Al I | nvent ory. xI sx workbook demonstrates how to create an editable
table with a denormalized master-detail relationship. It also demonstrates how to use
a date picker, group columns, and delete existing data records.

The Edi t Cust oner s. x| sx workbook illustrates the most commonly used ADF
Desktop Integration ADF Table component features. You can download, insert,
update and commit data. It also demonstrates multiple ways to choose a value from a
list of choices.

The Edi t WAr ehousel nvent ory. x| sx workbook illustrates how to use ADF
Desktop Integration form components with a detail table. You can download and
update data in a master form and its detail table. This sample also demonstrates how
to use workbook parameters to control the workbook initialization.

Subsequent sections in this chapter provide more information about the functionality
in the workbooks along with cross-references to implementation details.

2.4.1 Log on to the Fusion Web Application from an Integrated Excel Workbook

At runtime, the integrated Excel workbooks in the Summit sample application for
ADF Desktop Integration render an Excel ribbon tab that allows end users to log on to
the Fusion web application. Figure 2-2 shows the runtime Customers tab in the Ribbon
of the Edi t Cust orer s. x| sx workbook.

Figure 2-2 Runtime Customers Tab
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2.4.2 Downloading Data Rows

Some workbooks, such as Edi t Cust oner s. x| sx workbook, use an ADF Table
component to download information from the Fusion web application. This
component allows end users to edit rows and upload modified rows to the Fusion web
application.

The following sections provide information about how to implement the download
functionality:

e FEach worksheet that you integrate with a Fusion web application requires an
associated page definition file.
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For example, the Cust orrer s worksheet in the Edi t Cust onmer s. x| sx workbook
is associated with the Excel Cust oners. ximl page definition file. In JDeveloper,
expand the following nodes in the Applications window to view this file:

ViewController > Application Sources > oracle.summitdi.view > pageDefs

For information about how to configure a page definition file, see Working with
Page Definition Files for an Integrated Excel Workbook.

¢ The ADF Table component Downl oad action downloads data from the Fusion web
application to the worksheet. For information about how you invoke this action,
see Downloading Data to an ADF Table Component.

¢ Inthe Edi t Cust oner s. x| sx workbook, the worksheet St ar t up event invokes
an action set that includes the ADF Table component Downl oad action. For
information about configuring worksheet events, see How to Invoke an Action Set
from a Worksheet Event.

2.4.3 Modify Customers and Warehouses Information in the Workbooks

The Edi t Cust oner s. x| sx and Edi t War ehousel nvent ory. x| sx workbooks
enable end users to edit customers and warehouses information that the ADF Table
component and form components downloads from the Fusion web application.
Columns in the runtime ADF Table component that have an Updat eConponent
property configured permit end users to modify values and upload the changes to the
Fusion web application. For example, end users can modify the values that appear in
the Name, Phone, and Address columns in Edi t Cust oner s. x| sx.

Other columns, such as Status and Changed, appear in the ADF Table component to
provide status information about upload operations and changed columns.

The following sections provide information about how to implement this
functionality:

¢ For information about inserting an ADF Table component, see Inserting an ADF
Table Component into an Excel Worksheet.

¢ For information about special columns, such as Status and Changed, see Special
Columns in the ADF Table Component.

e For information about action sets, see Adding Interactivity to Your Integrated Excel
Workbook.

¢ For information about lists of values, see Working with Lists of Values.

2.4.4 Upload Modified Information to the Fusion Web Application

The integrated workbooks allow end users to upload modified data in the ADF Table
component to the Fusion web application. An action set is configured for the runtime
Upload ribbon command that invokes the ADF Table component's Upl oad action. For
information about implementing this functionality, see Uploading Changes from an
ADF Table Component .
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Setting Up Your Development Environment

This chapter describes how to set up the development environment to integrate an
Excel workbook with a Fusion web application, how to upgrade and remove ADF
Desktop Integration.

This chapter includes the following sections:
* About Setting Up Your Development Environment

¢ Required Oracle ADF Modules and Third-Party Software

Installing ADF Desktop Integration

* Removing ADF Desktop Integration

Upgrading ADF Desktop Integration

3.1 About Setting Up Your Development Environment

Setting up the development environment involves making sure that you have the
correct versions of JDeveloper and Microsoft Office installed, as described in Required
Oracle ADF Modules and Third-Party Software.

After verifying that you have the required software, complete the setup of your
development environment by:

¢ Configuring Microsoft Excel to work with ADF Desktop Integration

¢ Installing ADF Desktop Integration

Note:

The instructions in this guide assume that you are using Windows 7 operating
system and Microsoft Excel 2007. Note that the steps might be different for
different editions of Windows and Excel.

3.2 Required Oracle ADF Modules and Third-Party Software

Before you begin to integrate your Excel workbook with a Fusion web application,
ensure that you have the required Oracle ADF modules and third-party software
installed and configured:

¢ Oracle JDeveloper

Install the current release of JDeveloper. ADF Desktop Integration is available as a
JDeveloper feature.
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Microsoft Windows

Microsoft Windows operating systems support the development and deployment
of Excel workbooks that integrate with Fusion web applications. For more
information about supported versions of Windows, click the "Certification
Information" link for this release on the following OTN page:

http://ww. oracl e. com t echnet wor k/ devel oper -t ool s/ dev/
docunent ati on/ i ndex. ht m

Microsoft Excel

ADF Desktop Integration supports the integration of Fusion web applications with
the following types of Excel workbook:

—  Excel Workbook

The default file format for Excel workbooks is the Excel XML-based file format
(. xI sx).

— Excel Macro-Enabled Workbook

Workbooks in this format (. x| sm) use the Excel XML-based file format and can
store VBA macro code.

ADF Desktop Integration does not support the use of other Excel file formats. For
more information about supported versions of Excel, click the "Certification
Information" link for this release on the following OTN page:

http: //wwv. oracl e. com t echnet wor k/ devel oper -t ool s/ j dev/
docunent ati on/ i ndex. ht m

Internet Explorer

Some features in ADF Desktop Integration use a web browser control from the
Microsoft .NET Framework. This browser control relies on the local Internet
Explorer installation to function properly.

ADF Desktop Integration uses Internet Explorer to render web pages inside Excel,
regardless of other browsers installed on the system or any other browser set as the
default browser.

Consider running the Client Health Check to determine if your environment is
configured correctly after you run the ADF Desktop Integration installer. For more
information, see Running the Client Health Check Tool.

3.3 Installing ADF Desktop Integration

When you run the ADF Desktop Integration installer, it verifies whether software in
the following list is installed on the system where you want to install the add-in. If one
or more of these pieces of software is not installed, the installer automatically
downloads and installs it in the order specified.

1.

2.

Windows Installer 3.1
Microsoft NET Framework

The Microsoft .NET Framework 4.5.2 provides the runtime and associated files
required to run applications developed to target the Microsoft NET Framework.
You can download the framework from ht t p: / / waw. m crosoft. conf

downl oad/ .
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Installing ADF Desktop Integration

Note:

¢ Microsoft NET Framework 4.5.2 is the minimum required version. ADF
Desktop Integration is also compatible with Microsoft .NET Framework
4.6.

¢ Installation of Microsoft .NET Framework may require you to restart the
system where you install it. After the restart, the installer automatically
recommences to finalize installation.

3. Microsoft Visual Studio 2010 Tools for Office Runtime

The Microsoft Visual Studio 2010 Tools for Office Runtime (version 4) is required to
run VSTO solutions for the Microsoft Office system. You can download the
Microsoft Visual Studio 2010 Tools for Office Runtime from ht t p: //

www. mi cr osof t. com downl oad/ .

4. ADF Desktop Integration add-in

You can install the ADF Desktop Integration add-in from JDeveloper, or from the
adf di - excel - addi n-i nst al | er. exe installer available in the following
directory:

MN HOME\ or acl e_common\ nodul es\ or acl e. adf . deskt opi nt egrati on

For more information about how to set up ADF Desktop Integration, see How to
Install ADF Desktop Integration. You can also install it from an ADF Desktop
Integration-enabled Fusion web application. For more information, see How to
Install the ADF Desktop Integration Add-in From a Web Server.

Note that the ADF Desktop Integration installation is specific to the current
Windows user profile. If you have multiple Windows user profiles on your system,
and you want to use ADF Desktop Integration integrated Excel workbooks from
some specific user profiles, you must log in to each user profile and install the ADF
Desktop Integration add-in. For more information, see How to Install ADF Desktop
Integration.

3.3.1 How to Install ADF Desktop Integration

You can install the ADF Desktop Integration add-in from JDeveloper, and then create
and test integrated Excel workbooks.

Although you do not require administrator privileges to install the ADF Desktop
Integration add-in, administrator privileges may be required to run the installer for
additional software that the installer attempts to download and install. You should
also ensure that the proxy settings for Internet Explorer are configured to allow access
to*. m crosof t. combecause the installer attempts to automatically download
missing prerequisite software from Microsoft's website.

Before you begin:

It may be helpful to have an understanding of ADF Desktop Integration requirements.
For more information, see Installing ADF Desktop Integration.

To install ADF Desktop Integration:

1. Open JDeveloper.

2. From the Tools menu, choose Install ADF Desktop Integration.
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Note:

The Install ADF Desktop Integration menu option is available only on the
Windows installation of JDeveloper.

3. In the ADF Desktop Integration Installer page of Oracle ADF Desktop Integration
12¢c Add-In for Excel wizard, click Install.

Follow the instructions that appear in the dialog boxes to successfully install the
required components. If you encounter an error during the installation process, an
error message with a description appears, and installation is rolled back. For more
details, check the adf di -i nstal | er-1 og. t xt error log file in the t enp
directory of the user profile.

4. If prompted, click Yes to restart the system and complete the install of ADF
Desktop Integration.

It may also be necessary to open Microsoft Excel to accept additional prompts to
allow the installation to complete.

Note the following points about installation:

* You can also install ADF Desktop Integration by running adf di - excel - addi n-
i nstal | er. exe available in the following directory:

MN HOVE/ or acl e_common/ nodul es/ or acl e. adf . deskt opi nt egrati on

Before you run the installer, remember that the ADF Desktop Integration add-in
installer does not enable designer features by default. You must enable the designer
features in the add-in to create and edit integrated Excel workbooks.

In the ADF Desktop Integration Installer page of the wizard, click Developer
Options, and then in the Developer Options page select the Enabled option, and
click Install. If you do not select the Enabled option, the Oracle ADF tab shown in
Figure 3-1 does not appear in Microsoft Excel.

Figure 3-1 Oracle ADF Tab in Microsoft Excel
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¢ Designer features are automatically enabled if you install ADF Desktop Integration
from JDeveloper.

* You can also install ADF Desktop Integration from the command line.

If you want to install ADF Desktop Integration for end users, see Installing,
Upgrading, and Removing ADF Desktop Integration.

3.4 Removing ADF Desktop Integration

Use the Microsoft Windows Control Panel to remove the ADF Desktop Integration
add-in from the system where you set it up. After removing ADF Desktop Integration,
you can no longer use integrated Excel workbooks on this system unless you reinstall
ADF Desktop Integration.
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To remove the ADF Desktop Integration add-in:

1. Click the Windows Start button, and then choose Control Panel.
2. In the Control Panel, select and open Programs and Features.

3. Select the Oracle ADF Desktop Integration 12c Add-in for Excel program and
click Uninstall.

Note:

If you have installed ADF Desktop Integration on multiple user profiles, you
must remove it from each user profile.

3.5 Upgrading ADF Desktop Integration

To upgrade to a new version, run the ADF Desktop Integration installer from the new
version. It is not necessary to uninstall the old version first.

You can run the installer from:
¢ JDeveloper Tools menu

* Welcome page of the running Fusion web application (see Verifying That Your
Fusion Web Application Supports ADF Desktop Integration )

¢ File system (see the Notes section of How to Install ADF Desktop Integration)

Note:

e If you are upgrading from a previous release, you may receive a message
that says that ADF Desktop Integration was installed with an incompatible
installer. In this case, you must uninstall the ADF Desktop Integration add-
in prior to running the installer.

* When you test your integrated Excel workbooks, ADF Desktop Integration
may prompt you with a dialog to install the add-in version that your test
server uses. Although this dialog contains an option to skip, you, as a
developer, should never skip the installation of the add-in version that the
dialog proposes. It is important to keep the version of the add-in that the
client uses synchronized with the ADF Desktop Integration servlet version.
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Preparing Your Integrated Excel Workbook

This chapter describes how to prepare Excel workbooks and integrate them with
Fusion web applications using ADF Desktop Integration, how to use the page
definition files with an integrated Excel workbook, and how to enable ADF Desktop
Integration manually to integrate an existing workbook with the Fusion web
application.

This chapter includes the following sections:

* About Preparing Your Integrated Excel Workbooks

¢ Working with Page Definition Files for an Integrated Excel Workbook
* Adding an Integrated Excel Workbook to a Fusion Web Application

¢ Enabling ADF Desktop Integration in an Excel Workbook

¢ Enabling ADF Desktop Integration Manually

* Using an Integrated Excel Workbook with Older Versions of ADF Desktop
Integration

4.1 About Preparing Your Integrated Excel Workbooks

This chapter (and the guide as a whole) assumes that you have developed a
functioning Fusion web application, as described in Developing Fusion Web Applications
with Oracle Application Development Framework.

Having developed the Fusion web application, you perform the tasks described in this
chapter to configure an integrated Excel workbook with the Fusion web application.
The subsequent chapters of the guide enable you to configure the integrated
workbook with Oracle ADF components that provide the functionality you require at
runtime.

Note:

Before you start, ensure that designer tools of ADF Desktop Integration are
enabled. For more information, see Installing ADF Desktop Integration.

4.2 Working with Page Definition Files for an Integrated Excel Workbook

Page definition files define the bindings that populate the data in the Oracle ADF
components at runtime. Page definition files also reference the action bindings and
method action bindings that define the operations or actions to use on this data. You
must define a separate page definition file for each Excel worksheet that you are going
to integrate with a Fusion web application.
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The ADF Desktop Integration task pane displays only those bindings that ADF
Desktop Integration supports in the bindings palette. If a page definition file
references a binding that ADF Desktop Integration does not support (for example, a
graph binding), it is not displayed.

Table 4-1 lists and describes the binding types that the ADF Desktop Integration
module supports.

Table 4-1 Binding Requirements for ADF Desktop Integration Components

ADF Desktop Supported Binding Additional comments
Integration
component

ADF Input Text  Attribute binding

ADF Output Text  Attribute binding

ADF Label Attribute and list bindings This ADF Desktop Integration component
uses the label property of a control binding.

ADF List of List binding

Values

ADF Read-only Tree binding
Table

ADF Table Tree binding

For information about the bindings that components in ADF Desktop Integration use,
see ADF Desktop Integration Component Properties and Actions.

For information about the elements and attributes in page definition files, see the
"pageNamePageDef.xml" section of Developing Fusion Web Applications with Oracle
Application Development Framework.

For information about ADF data binding and page definition files in a Fusion web
application, see the "Using ADF Model in a Fusion Web Application" chapter of
Developing Fusion Web Applications with Oracle Application Development Framework.

4.2.1 How to Create ADF Desktop Integration Page Definition File

You create and configure a page definition file that determines the Oracle ADF
bindings to expose in the JDeveloper project.

Before you begin:

It may be helpful to have an understanding of page definition files. For more
information, see Working with Page Definition Files for an Integrated Excel
Workbook.

To create an ADF Desktop Integration page definition file:
1. Open the Fusion web application in JDeveloper.

2. In the Applications window, select the user interface project, such as
ViewController, to which you want to add the page definition file.

3. From the File menu, choose New > From Gallery.
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4. In the New Gallery, expand Client Tier, select ADF Desktop Integration, then
ADF Desktop Integration Page Definition, and then click OK.

Figure 4-1 shows the New Gallery with ADF Desktop Integration category and the
ADF Desktop Integration Page Definition option.

Figure 4-1 New Gallery - ADF Desktop Integration Page Definition
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Click OK.

5. In the Create ADF Desktop Integration Page Definition dialog, if required, edit the
page definition file name.

6. Click OK.

JDeveloper adds the page definition into the Fusion web application and opens the
new page definition's editor. Figure 4-2 shows the ViewController project with the
new page definition in the Applications window.

Figure 4-2 adfdiPageDefn.xml in Applications window
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For information about working with page definition files, see the "Working with Page
Definition Files" section in Developing Fusion Web Applications with Oracle Application
Development Framework.
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4.2.2 What Happens When You Create a Page Definition File

JDeveloper creates the Dat aBi ndi ngs. cpx file the first time you add a page
definition file in the JDeveloper project using the procedure described in How to
Create ADF Desktop Integration Page Definition File.

The Dat aBi ndi ngs. cpx file defines the binding context for the Fusion web
application and provides the configuration from which the Oracle ADF bindings are
created at runtime. Information about working with this file can be found in the
"Working with the DataBindings.cpx File" section of Developing Fusion Web Applications
with Oracle Application Development Framework. Information about the elements and
attributes in the file can be found in the "DataBindings.cpx" section of the same guide.

4.2.3 How to Reload a Page Definition File in an Excel Workbook

If you make changes in your JDeveloper desktop integration project to a page
definition file that is associated with an Excel worksheet, rebuild the JDeveloper
desktop integration project and reload the page definition file in the Excel worksheet
to ensure that the changes appear in the ADF Desktop Integration task pane. You
associate a page definition file with an Excel worksheet when you choose the page
definition file, as described in How to Configure a New Integrated Excel Workbook.

The Oracle ADF tab provides a button that reloads all page definition files in an Excel
workbook.

Errors may occur when you switch an integrated Excel workbook from design mode
to runtime if you do not rebuild the JDeveloper desktop integration project and restart
the application after making changes to a page definition file. For example, if you:

¢ Remove an element in a page definition file
* Do not rebuild and restart the Fusion web application

¢ Or do not reload the page definition file in the integrated Excel workbook

an error message such as the following may appear when you attempt to switch a
workbook to test mode:

[ ADFDI - 05530] unable to initialize worksheet: M/Wrksheet
[ ADFDI - 05517] unable to find control MBI ndi ngThat WasRenoved

Before you begin:

It may be helpful to have an understanding of page definition files. For more
information, see Working with Page Definition Files for an Integrated Excel
Workbook.

To reload page definition files in an Excel workbook:
1. Ensure that you have saved the updated page definition file in JDeveloper.

2. In the Excel workbook, click the Refresh Bindings button in the Components
group of the Oracle ADF tab.

For information about the Refresh Bindings button, see About Development Tools.
After reloading the page definition file, the ADF Desktop Integration task pane of the

worksheet displays the same bindings that are available in its associated page of the
Fusion web application. For example, Figure 4-3 shows the bindings in the
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Excel Cust orer s. xml page definition file and the same bindings in the worksheet
of the Edi t Cust oner s- DT. x| sx workbook.

Figure 4-3 Page Definition Bindings in JDeveloper and Integrated Excel Workbook

E ExcelCustomers.xml

al Anongs

Page Data Binding Definition
Available Bindings (ExcelEditCustomers):
This shows the Orade ADF data bindings defined for your pagi

[‘l Customers (tree)

@ Createlnsert (action)
@ Commit (action)

Data Binding Registry: orade /summitdi/view /DataBindings.q

Bindings and Executables ~ Contextual Events = Parame &2} Execute (action)
BT GF / % Insert Binding
@ Customers
Createlnsert
[ Commit Worksheet Properties...
Execute Waorkbook Properties .
Page Definition Bindings in JDeveloper Page Definition Bindings in Excel

4.2.4 What You May Need to Know About Page Definition Files in an Integrated Excel
Workbook

Note the following points about page definition files in an ADF Desktop Integration
project:

¢ Integrating Multiple Excel Worksheets: You can integrate multiple worksheets in
an Excel workbook with a Fusion web application. You associate a separate page
definition file with each worksheet as described in How to Add Additional
Worksheets to an Integrated Excel Workbook.

e EL Expressions in a Page Definition File: Use the following syntax to write EL
expressions in a page definition file:

Dynani ¢ (${})

Do not use the syntax Def erred (#{}) to write EL expressions. EL expressions
using this syntax generate errors because they attempt to access the ADF Faces
context, which is not available.

Note:

EL expressions that you write for ADF Desktop Integration component in the
integrated Excel workbook, such as the Input Text component, must use the
Deferred (#{}) syntax.

4.3 Adding an Integrated Excel Workbook to a Fusion Web Application

The Fusion web application is automatically enabled with ADF Desktop Integration
when you add an integrated Excel workbook to a project. An integrated Excel
workbook enables you to add ADF components and ADF data bindings.

4.3.1 How to Add an Integrated Excel Workbook to a Fusion Web Application

To add an integrated Excel workbook, open the Fusion web application in JDeveloper
and add an Excel workbook to the project from New Gallery.
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Before you begin:

It may be helpful to have an understanding of adding ADF Desktop Integration to a
Fusion web application. For more information, see Adding an Integrated Excel
Workbook to a Fusion Web Application.

To add an integrated Excel workbook in JDeveloper:

1.

2.

Open the Fusion web application in JDeveloper.

In the Applications window, select the user interface project, such as
ViewController, to which you want to add the new integrated Excel workbook.

From the File menu, choose New > From Gallery.

In the New Gallery, expand Client Tier, select ADF Desktop Integration, then
Microsoft Excel Workbook, and then click OK.

Figure 4-4 shows the New Gallery with ADF Desktop Integration category and the
Microsoft Excel Workbook option.

Figure 4-4 New Gallery - Microsoft Excel Workbook

© ™
T o=
Q
Categories: Items: Show All Descriptions

----- Contexts and Dependency Inject E ADF Desktop Integration Page Definition

'''' Data Controls Launches the Create ADF Desktop Integration Page Definition dialog, in which you
""" I8 create a new Page Definition for use in a ADF Desktop Integration-enabled Excel
""" Security workbook. To enable this option, you must select a project or a file within a project in
..... TopLink/IPA the application navigator.
..... V! i

E}---Clie:t‘l%irsemces Microsoft Excel Workbook
Launches the Create ADF Desktop Integration-Enabled Excel Workbook dialog, in

. = which you create a new ADF Desktop Integration-enabled Excel workbook in a

""" ADF Sning spedfied location. To enable this option, you must select a project or a file within a
""" Extension Development project in the application navigator,
-~ Bwing [AWT

=~ Database Tier

----- Database Files

----- Database Objects

----- Offline Database Objects
[=-Web Tier

PUTR Fom—

Help oK Cancel

Click OK.

In the Create ADF Desktop Integration-Enabled Excel Workbook dialog, verify the
desired location and type a unique workbook name. Consider adding a suffix of -
DT to help with publishing later. For example, MyWor kbook- DT. x| sx.

By default, the integrated Excel workbook is saved as adf di - wor kbook-

DT. x| sx in the <PROJECT_HOME>\ sr c\ excel directory of the selected project.
Although you can save the workbook anywhere you choose, you should save the
workbook with the other files of the Fusion web applications.

Later, ADF Desktop Integration removes suffixes, such as - DT, when you publish
the finalized integrated Excel workbook for distribution so that end users see
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meaningful filenames. For example, the Summit sample application publishes the
workbook to edit customers using the Edi t Cust orer s. x| sx filename rather
than Edi t Cust onmer s- DT. x| sx.

6. Click OK.

JDeveloper adds the integrated Excel workbook into the Fusion web application, and
automatically enables the project with ADF Desktop Integration. Figure 4-5 shows the
ViewController project.

Figure 4-5 adfdi-workbook-DT.xIsx in Applications window

Applications
Application2 o | et

=| Projects Bl®@- V-3
Model
=-{E] ViewController

=+ Application Sources

-0 excel

b adfdi-workbook-DT. xlsx
- @[30 META-INF
&[0 Web Content

+| Application Resources
+| Data Controls

+| Recent Files

+| Working Sets

4.3.2 How to Configure a New Integrated Excel Workbook
After adding the integrated Excel workbook, you must configure it.
Before you begin:

It may be helpful to have an understanding of adding an integrated Excel workbook to
a Fusion web application. For more information, see Adding an Integrated Excel
Workbook to a Fusion Web Application.

To configure a new integrated Excel workbook:

1. Open the integrated Excel workbook.

¢ If you have saved the workbook with other files of the Fusion web application,
the Page Definition dialog automatically appears, as illustrated in Figure 4-6.
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Figure 4-6 Page Definition Dialog

i =

Page Definition @

Choose a Page Definition

BExicel Edit Alllmverntory

ExcelEditCustomers

ExcelSearchCustomers
BExcelWarehouseInventony
oracle_summitdi_view_MainPage Page Def
oracle_summitdi_view_searchFomPage Def

Cancel

Select the page definition file for the active worksheet from the Page Definition
dialog, and click OK.

If you have saved the workbook elsewhere, configure the workbook as
described in How to Manually Configure a New Integrated Excel Workbook.

2. In the Workbook group of the Oracle ADF tab, click Workbook Properties.

3. In the Edit Workbook Properties dialog, set or verify the values for the following
properties so that you can switch between design mode and test mode as you
configure the workbook:

Appl i cati onHoneFol der

The value for this property corresponds to the absolute path for the root
directory of the JDeveloper application workspace (. j ws). If the workbook is
located within the JDeveloper application workspace, the value of the

Appl i cati onHoneFol der workbook property is assigned automatically.

Note:

If you are opening the Excel file after moving the application directory, ensure
that the Appl i cati onHoreFol der property's value reflects the correct path.

Pr oj ect

The value for this property corresponds to the name of the JDeveloper project

(. j pr) in the JDeveloper application workspace. To change the project, click the
browse (...) icon and choose the project from the Project dialog, which lists the
projects defined in the JDeveloper application workspace.

By default, Pr oj ect is set to the name of the project that contains the Excel
document. ADF Desktop Integration loads the names of the available projects
from the appl i cati on_nane. j ws specified as a value for

Appl i cati onHoneFol der.

WebAppRoot
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Set the value for this property to the fully qualified URL for the web context
root that you want to integrate the Fusion web application with. The fully
qualified URL has the following format:

htt p:// <host name>: <por t nunber >/ cont ext - r oot

In JDeveloper, you specify the web context root (Cont ext - r oot ) in the Java EE
Application page of the Project Properties dialog. Figure 4-7 shows the web
context root used for the Summit sample application for ADF Desktop
Integration in JDeveloper and integrated Excel workbook.

Figure 4-7 Setting Web Context Root in JDeveloper and Integrated Excel
Workbook

i~ — ™
@) Project Properties - D\Cracle\Applications\Summit_ADFdi\WiewController\ViewController.jpr - M
Search Java EE Application
[ Project Source Paths () Use Custom Settings
[ ADF Business Components (3) Use Project Settings
[} ADF Model —
..... ADF View The following properties are used when running this project as a Java EE module or application
in the integrated WLS server.
[+~ Ant
[+ Compiler
) Java EE Web Application Name:
----- Dependendes - i
_____ Deployment |Summ|tADF iApp |
""" EJB Madule Java EE Web Context Root:
----- Extension |summiﬂ |
----- Facelets Tag Libraries
..... Features Integrated WLS Command Line:
[ Javadoc g{jvm} &fjava.options}
----- Java EE Application
..... IPA
----- JSP Tag Libraries
----- 15P Visual Editor
Restore Command Line Default
OK Cancel
—_!J
S ntll
Edit Workbook Properties @

Edit the properties and press OK to save your changes.

4 Data »

> Brandingltems Brandingltems (5) s
Parameters
RemoteServietPath fadfdiRemote Serviet

> Resources UlResources from web app =
‘webAppRoot http-/Aocalhost - 7101/summit

Beset WorkbookID

Securily

[ ok || cCancel |

Note that the fully qualified URL is similar to the following if you set up a test
environment on your system using the Summit sample application for ADF
Desktop Integration:

http://1ocal host: 7101/ sunmi t
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For information about how to verify that the Fusion web application is online
and that it supports ADF Desktop Integration, see Verifying That Your Fusion
Web Application Supports ADF Desktop Integration.

If you are integrating an Excel file with a secure Fusion web application, you
should use the ht t ps protocol while entering the value for WebAppRoot . For
more information about securing the Fusion web application, see Developing
Applications with the WebLogic Security Service.

¢ \WebPagesFol der

Set the value for this property to the directory that contains web pages for the
Fusion web application. The directory path should be relative to the value of
Appl i cati onHormeFol der . For example, in the Edi t Cust oner s- DT. x| sx
workbook, WebPagesFol der isset to Vi ewControl | er\public_htm.

Figure 4-8 shows an example of workbook properties in the Edit Workbook
Properties dialog of the Summit sample application for ADF Desktop Integration
Edi t Cust omer s- DT. x| sx workbook.

Figure 4-8 Edit Workbook Properties Dialog

Edit Workbook Properties @

Edit the properties and press OK to save your changes.

B2

4 Behavior
AutoDisplayStatusViewerEnabled True
> Compatibility
> Runtime Ribbon Tab
4 Data
> Brandingltems Brandingltems (5)
Parameters
RemoteServletPath fadfdiRemoteServiet
UlResources from web app
http-/Aecalhost-7101/summit

ApplicationHomeFolder D:\install\jdev\JDEVADF_MAIN_GENERIC_141
CustomizationEnabled False
Project ViewController
‘WebPagesFolder ViewController\public_html
‘wiorkbooklD 137c6b77-d905-4ad -8 7ecf5900402:f 36
> Secunty
Reset WorkbooklD
Design
oo
4. Click OK.
Note:

In Step 1, if the fully qualified path of the selected page definition file exceeds
the Windows path length limit, a warning message appears when the
Workbook Properties dialog is closed, and the page definition will not load.

5. Save the Excel workbook.

4.3.3 How to Add Additional Worksheets to an Integrated Excel Workbook

To use Oracle ADF functionality, associate each worksheet with a page definition file.
You associate a page definition file with a worksheet when you add a worksheet to the
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integrated Excel workbook. You can integrate multiple worksheets in an integrated
Excel workbook with a Fusion web application. Use a different page definition file for
each worksheet in the integrated Excel workbook.

Before you begin:

It may be helpful to have an understanding of adding an integrated Excel workbook to
a Fusion web application. For more information, see Adding an Integrated Excel
Workbook to a Fusion Web Application.

To associate a page definition file with an Excel worksheet:

1. While the Excel workbook is in design mode, click the Home tab in the Excel
ribbon, and then choose Insert > Insert Sheet in the Cells group.

2. In the Choose Page Definition dialog, select the page definition file.

This populates the bindings palette in the ADF Desktop Integration task pane with
the bindings contained in the page definition file. You can now configure the
worksheet with Oracle ADF functionality.

4.4 Enabling ADF Desktop Integration in an Excel Workbook

Workbooks that you create, as described in Adding an Integrated Excel Workbook to a
Fusion Web Application, are automatically configured to use ADF Desktop
Integration functionality. For existing Excel workbooks, you must enable ADF
Desktop Integration in the workbook to make it an integrated Excel workbook and
configure a number of properties in the newly-integrated Excel workbook.

4.4.1 How to Enable ADF Desktop Integration in an Existing Workbook

To integrate an existing workbook with the ADF Desktop Integration enabled Fusion
web application, you must manually enable ADF Desktop Integration for the
workbook. For information about the supported file formats of Excel workbooks that
you can use for integration with a Fusion web application, see Required Oracle ADF
Modules and Third-Party Software.

Before you begin:

It may be helpful to have an understanding of adding integrated Excel workbook to a
Fusion web application. For more information, see Adding an Integrated Excel
Workbook to a Fusion Web Application.

To enable ADF Desktop Integration in an existing Excel workbook:

1. In Excel, open the workbook.
2. In the Workbook group of the Oracle ADF tab, click Workbook Properties.

3. In the Enable Workbook dialog, click Yes, as shown in Figure 4-9.
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Figure 4-9 Enable Workbook Dialog
5 ™

I.-”"_"\-. This workbook will be enabled to be used with Oracle ADF Desktop
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"' Integration 12¢. Do you want to continue?

ADF Desktop Integration prepares your workbook, displays the ADF Desktop
Integration Designer task pane, and opens the Browse For Folder dialog. For more
information, see How to Manually Configure a New Integrated Excel Workbook.

4. Save the workbook.

Although you can store the Excel workbooks that you integrate with Fusion web
applications anywhere you choose, there are several advantages to storing them with
the other files of the Fusion web application. Some of these advantages are:

® Source control of the workbooks
¢ Facilitating the download of workbooks from web pages

* The file system folder picker that appears the first time a workbook is opened
defaults to the location where you store the workbook

For example, the Summit sample application for ADF Desktop Integration stores the
Excel workbooks it integrates in the following subdirectory:

Sunmit _HOMVE\ Vi enControl | er\src\oracl e\ sunmm t di \ excel

where Sunmi t _HOME is the root directory that stores the source files for the Summit
sample application for ADF Desktop Integration.

4.4.2 How to Manually Configure a New Integrated Excel Workbook

After enabling ADF Desktop Integration manually in a workbook, you would need to
configure it.

Before you begin:

It may be helpful to have an understanding of adding an integrated Excel workbook to
a Fusion web application. For more information, see Enabling ADF Desktop
Integration Manually.

To manually configure a new integrated Excel workbook:

1. Open the integrated Excel workbook.

The Browse For Folder dialog automatically appears, as illustrated in Figure 4-10.
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Figure 4-10 Browse For Folder Dialog
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Use the Browse for Folder dialog to select the JDeveloper application home
directory. In a typical JDeveloper project, the J]Developer application home
directory stores the appl i cat i on_nane. j ws file. The value you select is
assigned to the Appl i cat i onHomeFol der workbook property.

Note:

The Browse for Folder dialog does not appear if the workbook is located
within the JDeveloper application workspace. In such a case, the value of the
Appl i cati onHoneFol der workbook property is assigned automatically.

. In the Workbook group of the Oracle ADF tab, click Workbook Properties.

. In the Edit Workbook Properties dialog, configure the properties as described in
Step 3 of How to Configure a New Integrated